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System Requirements

•Windows 95, 98, or NT4.0

•Pentium 100 MHz (133+ recommended)

•20 MB RAM (32 MB recommended)

•800 x 600 or higher SVGA screen resolution

•CD-ROM drive

Hints and Tips for Using This CD-ROM

Skim through this Quick Start Guide and familiarize yourself with
the CD-ROM contents and capabilities.

Send your questions to cfs@bts.gov.

We would also like to hear your comments about the CD-ROM and
your suggestions for future improvements.  The next Commodity
Flow Survey will be conducted in the year 2002.

Also, take a look at the Commodity Flow Survey Internet site at
http://www.census.gov/econ/www/cfsmain.html or www.bts.gov.
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Licensing Info

This CD-ROM include software used under license from Ivation
Datasystems, Inc., Lotus Development Corporation, Adobe, and
Microsoft Corporation.  These software programs are subject to
copyright restrictions.  Permission to reproduce or distribute
copyrighted material must be obtained directly from the copyright
owner.

The Census Bureau’s 1997 Commodity Flow Survey; profiles,
summary tables, charts, and maps created from the data; and all
supporting documentation are not subject to copyright restrictions.

Beyond 20/20,  Beyond 20/20 Browser, Beyond 20/20 Builder,
Beyond 20/20 Distributor, ChartBrowse and MapBrowse, the Beyond
20/20 slogan, and the Ivation logo:  all are trademarks of Ivation
Datasystems Incorporated.

dBASE® is a registered trademark of Ashton-Tate Corporation.

Lotus® and 1-2-3® are registered trademarks of Lotus Development
Corporation.

Microsoft® and the Microsoft Internet Explorer logo are registered
trademarks of Microsoft Corporation in the United States and/or
other countries.

All other registered and unregistered trademarks are the property
of their respective holders.
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What Is the Commodity Flow Survey?

The 1997 Commodity Flow Survey (CFS) is undertaken through a
partnership between the U.S. Census Bureau, U.S. Department of
Commerce, and the U.S. Department of Transportation, Bureau of
Transportation Statistics.  This survey produces data on the
movement of goods in the United States.  It provides information on
commodities shipped, their value, weight, and mode of transporta-
tion, as well as the origin and destination of shipments.

The data from the CFS are used by public policy analysts and for
transportation planning and decision-making to assess the demand
for transportation facilities and services, energy use, safety, and
environmental concerns.

The 1997 CFS covers business establishments in mining, manufac-
turing, wholesale trade, and selected retail industries.  The survey
also covers selected auxiliary establishments (e.g., warehouses) of
in-scope multiunit companies.  The survey coverage excludes
establishments classified as farms, forestry, fisheries, governments,
construction, transportation, foreign establishments, services, and
most establishments in retail.
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What’s on the 1997 Commodity Flow
Survey CD-ROM?

• About the CFS - Descriptions of the survey coverage, terminology,
and methodology used to produce the CFS data.

• Frequently Asked Questions - Answers to frequently asked
questions about the CFS data and the CD-ROM capabilities.

• Predefined Data Tables - A wide range of CFS tables for access by
the Ivation software, organized by geography, including:

—National
—Census regions and divisions
—States
—Selected metropolitan areas and remainder of states

• In addition, each predefined table has a companion table which
shows the measures of sampling variability for each published
data item.

• View Only Tables - CFS data presented in PDF format suitable for
viewing and printing.  In addition to selected tables from the
national and state data series, the CD-ROM also includes tables for
states, metropolitan areas and remainder of states tables, as well
as additional reports on hazardous material shipments and
exports.  We have also included reports for Census regions and
divisions.
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• Maps - We have included maps in JPG format for each of the
metropolitan areas.  In addition, we have provided a file in ASCII
format that lists the counties comprising metropolitan areas and
remainder of states.

Beyond 20/20 Browser Concepts

A table is the format in which the data is displayed.

A dimension describes an attribute of the table data. Beyond 20/20
tables can have up to eight dimensions.

An item is an element of a dimension (e.g. private truck is an item
of mode of transportation).

Getting Started

Looking at the Data

To start the Beyond 20/20 Browser, click on “Data” on the first menu
screen. Then click on “Predefined Tables” then select desired geogra-
phy. By default, when the Browser opens, the Find dialog box appears
to provide you with a quick and easy way to find and open a table.
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Finding a Table

If you’re not already in the Find dialog box, click on the
Find button in the toolbar.

Confirm or modify the path shown in the Directory box so that it’s
pointing to the directory that contains the tables you want to
browse such as:  b2020/data/states for individual state tables.

Select the geography that most likely contains the tables you need.
A list of tables belonging to that category is displayed.

Opening a Table or an Extract

Open a Beyond 20/20 table by double-clicking on its name in the
Find dialog box.

Note:  To browse the tables you create from an extract, see
“Working With Tables” below.
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Working With Tables

Table Browsing

Once you have opened a
table, you can browse
through the items in any
dimension. First you must
make the dimension
active by clicking on one
of the dimension tiles in
the Dimension bar.  You’ll
notice that the dimension
is now shown in the
Active Dimension box.
Click the Previous Item

button or the Next Item button to browse through the data for the
items in that dimension. Note that each dimension tile shows the
dimension name and the code or label of the item for which data
are currently displayed.

Switching Table Dimensions

Once you have opened a table, you are in the table view. You can
change your view of the table by dragging and dropping dimension
tiles with the mouse, one at a time.
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Nesting Table Dimensions

You can view more than one dimension at the same time along
either the rows or the columns by nesting dimensions.  Nesting
means showing one dimension within another.  With the left mouse
button depressed, slowly drag the desired dimension tile from the
Dimension bar to the top or bottom edge of the column labels, or
to the right or left edge of the row labels, until a thick line (or
highlight) appears.  Release the mouse button to nest the dragged
dimension.

Selecting Data From a Table

To reduce the amount of displayed data, to move data to another
application, or to chart or map data, you first need to select it.

• To select a row or a
column of data, click on
the corresponding row
or column heading.

• To select multiple
consecutive rows or
columns, drag the
mouse across the row or
column headings.
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• To select nonadjacent rows and/or columns, press the CTRL key
while you click on the row and/or column headings.

With your selection highlighted, click on the right mouse button for
the shortcut menu, then select the desired operation. You can show,
hide, chart, copy, or print the selected items.

For example, if viewing the symbol column for a particular table is
not required, you may choose to hide them by clicking the right
mouse button and selecting “hide.”  To undo the hide, simply right
click the column heading bar and select “show all.”

The symbol column is present to indicate why a given cell is not
shown.  There are three reasons why a cell may show a “-” instead
of a number:

1) Represents zero or less than 1 unit of measure.

2) Data do not meet publication standards due to high sampling
variability or other reasons.

3) Denotes figures withheld to avoid disclosing data for individual
companies.

To determine why a cell was not published, click on the appropriate
“symbol” cell.  The definition of the symbols presented will appear.
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Searching for Items Along a Dimension

You can reduce the items shown along a dimension by
displaying only the ones you want. To search for items
along a dimension:

1. Make the dimension active by clicking on the appropriate
dimension tile.

2. Click on the Search Dimension button in the toolbar.

3. In the Search dialog box, click on the Data field if you want to
search the data, then enter minimum and/or maximum values to
constrain your search.  When you choose OK, Beyond 20/20
searches the active items and shows only those items that have
satisfied your criteria.

OR

In the Search dialog box, click on the field you want to search, then
enter the text string that you want to search for in the Text to Find
box. When you choose OK, Beyond 20/20 searches the field you
selected and shows only those items that contain the text string
specified.

Note: To jump to a desired item along a dimension, choose Find
Next.
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Sorting Data Across a Dimension

You can sort items across a dimension to reorder them
in the table view. To sort items across a dimension:

1. Make the dimension active by clicking on the
appropriate dimension tile.

2. Click on the Sort Dimension button in the toolbar.

3. If you want to sort the dimension based on the data
values, click on the Data field in the Sort dialog
box. Then click on either Increasing or Decreasing,
and choose OK.

OR

If you want to sort the dimension based on the codes or labels
associated with it, click on the field that you want to sort, then
indicate the Sort Option and choose OK.

Creating Percentage Distributions

You can display numeric values distributed as percentages of row,
column, or table totals.

1. Choose Distributions from the View menu.
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2. Select the dimension you want to include in the distribution
calculation.  Note that the row and column dimensions are
automatically included in the distribution calculation.

3. Clear any check boxes for those items you want to exclude from
the new distribution dimension.

4. Click OK.

Beyond 20/20 creates a new table view with a new dimension
called Distributions.  This dimension contains one item for each
type of distribution you’ve selected.

Saving and Opening Views

A saved view is a personalized snapshot of a table that allows you
to quickly recall a specific layout of a table without having to
redefine its attributes.  Dimension order and nesting, item selec-
tions, column widths, and decimal settings are all examples of
attributes that are stored in a view.

• To permanently change the default view of a table, you must have
permission to modify the table.  Arrange the table in the layout
you wish to save and choose Save from the view menu.  The next
time you open the table the saved view will automatically appear.

• If you are in a read-only table or you don’t want to permanently
modify the default view of a table:
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1.  Arrange the table in the layout you wish to save.

2.  Choose Save As from the File menu and clear the Include
Numeric Data check box.

3.  Name the view and specify its location.

4.  Click OK.

A view saved in this fashion can be recalled by choosing Open from
the View menu and selecting the view filename.  This method of
saving a view can also be used to save multiple views for one table.

Printing a Table, Chart, or Map

To print a table view, chart view, or map view, click on the right
mouse button to see the shortcut menu and select the Print option.

Saving a Table

To save a table (or a subset of one) as a new Beyond 20/20 table,
choose Save As from the File menu. You can also save Beyond 20/
20 table data in several other formats, including dBase (.dbf),
comma-separated value (.csv), and Lotus (.wks). When saving to any
non-Beyond 20/20 format, you’ll need to nest all the dimensions
along the rows and/or columns before you save if you want to
retain the data for these dimensions (see “Nesting Table Dimen-
sions’’ on page 9).
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Performing Calculations

You can apply formulas to items in a dimension to create a com-
puted group.  For example, you can sum two items together and
divide the results by two.

1. Choose Define Group from the Item menu.

2. Enter a unique name or group code to represent the result of the
formula.

3. Choose the Computed Group Type.

4. Enter a formula to describe how the new group is to be calculated.
For example, (item1+item2)/2.

5. Click OK and proceed with calculation of the group.

Charting Data

You can choose from many chart types to display table
data. To create a chart:

1.  Select the rows and/or columns that you want to chart.

2.  Click on the Display Chart button in the toolbar.

3.  With the mouse pointer in the chart view, click on the right mouse
button to see the Charting shortcut menu.

4.  Choose Chart Options to change the current chart type.

5.  Make a selection and click OK to return to the chart view.
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ChartBrowse

The ChartBrowse feature lets you view a series of charts in rapid
succession so that you can quickly and easily see trends and
variations in the data.

1.  With the mouse pointer in the chart view, select one of the
headings in the title of the chart to make that dimension active.

2.  Use the Previous Item and Next Item buttons in the toolbar to chart
the previous or next item.


